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MLA Style Papers: Step-by-step Instructions for
Formatting Research Papers
Posted by Dennis G. Jerz, on May 29th, 2011

Jerz > Writing > Academic >

0.1) If you’ve been asked to submit a paper in MLA format, your instructor is asking
you to format the page and present the content in a specific way. Just as football
referees dress a certain way, and Japanese chefs cook a certain way, writers in
certain disciplines follow a certain set of conventions, known as MLA format or MLA
style. This document will show you how to format a paper in MLA style.

0.2) If, instead of questions about format, you have questions about why and how to
write an academic paper, see instead my handouts on writing a short research paper,
coming up with a good thesis statement, and using quotations in the body of your
paper.

0.3) On this page:

Document Settings
(1 inch margins; double spaced; 12-point)

1.

Page Header
(name and page number, upper right of every page)

2.

Title Block
(assignment info and an informative title)

3.

Citations
(no comma between the author and page number; commas and periods go outside of inline quotes)

4.

Works Cited List
(lots of tricky details! sort alphabetically by author, not by the order the quotes appear in your paper)

5.

For the most complete information, check your campus library or writing center for the MLA Handbook for Writers of Research Papers,
7th ed.
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1. Document Settings

Your word processor comes with default settings (margin, line height, paragraph spacing, and typeface) that will likely need
adjustment. For MLA style, you need:

1-inch margins all around1.
2.0 line height (double-spaced)2.
no extra spacing after paragraphs3.
12-point typeface (usually Times New Roman)4.

(Jump directly to instructions for adjusting MS-Word settings in Windows or Mac; or, skip ahead to 2) Page Header.)

1.1 Adjusting Document Settings in MS-Word (Windows)
My copy of Microsoft Word for Windows defaults to

1-inch margins all around1.
1.15 line height2.
10pt spacing between paragraphs3.
Calibri 11-point  typeface.4.

Changing to MLA Style (Windows)

The default margins in my test run were fine, but if you need to change them:
Page Layout -> Margins -> Normal (1-inch all around)

1.

The default line height is too low. Change it to 2.0.
Home -> Line Spacing -> 2.0.
(You could try fudging it to 1.9 or 2.1 to meet a page count, but any more than that and your instructor may
notice.)

2.

The MS-Word default adds extra space after paragraphs.(MLA Style instead requires you to  signal
paragraph breaks by indenting the first line.)
CTRL-A (select all your text)
Home -> Line Spacing -> Remove Space After Paragraph

3.

Change the typeface to Times New Roman 12-point.
Home -> Font Face Selector (change to Times New Roman)
Home -> Font Size Selector (change to 12)

4.

1.2 Adjusting Document Settings in MS-Word (Mac)

My copy of  Microsoft Word for Mac defaults to
1.25 inch left and right margins, 1 inch top and bottom1.
1.0 line height2.
no extra spacing after paragraphs3.
Cambria 12-point typeface4.

Changing to MLA style (Mac)

In my test run, the left and right margins are too big. To change them:
Layout -> Margins -> Normal (1-inch all around)

1.
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The default line height is too low. Change it to 2.0.
Home -> Line Spacing  -> 2.0

2.

My Mac copy of MS-Word does not add extra spaces after paragraphs. If yours does:
Home -> Line Spacing  -> Line Spacing Options… (a new window will pop up)
Don’t add space between paragraphs of the same style (check this box) -> OK

3.

The 12-point Cambria will probably be fine, but to change the typeface:
Home -> Font Face Selector (change to Times New Roman)
Home -> Font Size Selector (change to 12)

4.

2. Page Header

In the top right of every page, use your word processor’s “Page Header” function add an automatic page number and your surname.

2.1 Adding the Page Header in MS-Word (Windows)

Insert -> Page Number -> Top of Page -> (choose the right-justified “Plain Number” option)1.
The cursor will jump automatically to the right place for you to type your surname.2.
Click anywhere in the body of the paper to exit the header area.3.

2.2 Adding the Page Header in MS-Word (Mac)

Insert (in the top menu) -> Page Numbers…  -> (Set “Position” to “Top of Page (header)” and “Alignment” to “Right”)1.
Click just to the left of the new page number, and type your surname.2.
On my test document, my name was too far over to the left; grab the triangular tab adjuster just above your name, and drag
it a notch to the right.

3.

3. Title Block

In the upper left corner, type your name, your instructor’s name, the course number and section, and today’s date. Centered on the
next line, type an informative title that actually informs the reader of your main point (not just “English Paper” or “A Comparison
between Hamlet and Macbeth”).

Like all the other text in an MLA style paper, the title block is double-spaced.
The title is in the same font as the rest of the paper — it is not boldface, or enlarged.
There is no extra space above or below the title.
A truly informative title will include the general topic, and your precise opinion on that topic.  (So, if you pan to compare
Hamlet and Macbeth, your title should state the unique point you want to make about Hamlet and Macbeth. Reuse part of your
thesis statement.)

4. Citations
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This handout presumes you already know why you should cite your sources (to establish your authority, to introduce persuasive
evidence, to avoid plagiarism, etc.), These instructions focus on how you format the page. (For a resource to help you determine how
to cite a specific source, see the MLA Bibliography Builder).

To fully cite a source requires two stages.  The first happens in the body of your paper (the “in-text citation”) and the second happens
in a list at the of your paper (see “Works Cited List,” below.)

4.1 Citing a Block Quote (more than three lines)

Long quotes can start to look like filler. Only use a block quote if you have a very good reason to include the whole passage.
(You can usually make your point with a shorter quote.)
If you do have a good reason to quote a passage that is several lines long:

Select the text and click the “Increase Indent” icon (see image, right).
Place the parenthetical citation (the author’s name and the page number) after the period. (This is different
from inline quotes, below.)
There is no comma between the author’s name and the page number.
If the quotation runs across more than one page: (Wordsworth-Fuller 20-21) or (Wordsworth-Fuller 420-21).

Skip wordy introductions such as, ”In his informative guide The Amazing Writing Book, published by Elizabeth Mount College in
2010, the noted composition expert Maxwell Wordsworth-Fuller describes the importance of citations in MLA style papers.”
Cutting the filler leaves more room to develop your own original ideas. (See “Integrating Quotations.”)

4.2 Citing an Inline Quotation

When the passage you want to quote is less than three lines long, use inline style.  Here we have two brief passages, taken from the
same page of the same source, so we can handle both with a single parenthetical citation.

The parenthetical citation appears outside the quoted material.
The period that ends the sentence comes after the close parenthesis. (This is different from block quotes, above.)
In this example, we have changed the first word a little, lowercasing it in order to fit it into our own sentence. To let the reader
know what we changed, we put [] around it.
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Again, note the absence of a full sentence that explains who Wordsworth-Fuller is and where the quote comes from. All that info
will be in the Works Cited list, so we leave it out of the body of the paper.

4.3 Citing a Paraphrase

Let’s imagine we want to reference Wordsworth-Fuller’s general idea about citation as a way to establish credibility, but we don’t need
to include any of the technical details. We can save space, and make it much easier on our reader, if we paraphrase:

Use paraphrasing for variety, or to make a passing reference without taking up much space.
If we use an author’s idea, rephrased in our own words, we must still cite the idea.

5. Works Cited List

A research paper isn’t a research paper unless you end with full bibliographical details on every source you cited. This part can be
tedious and tricky; leave yourself plenty of time to do it.

Start a new page.
MS-Word Wind: Insert -> Page Break -> New Page.
MS-Word Mac: Document Elements -> Break -> Page.

Title your new page: Works Cited
MLA style calls for no extra spaces above or below the page title; no special formatting.

5.1.  How to Create an Individual Works Cited Entry
Exactly what goes into each item in your bibliography depends on what kind of item it is. The following pages give you some questions
to answer, then let you push a button to get an individual works-cited entry.

MLA-Style Bibliography Builder: Create Works Cited Entries by Filling in a Form

Article (in a periodical, or chapter; printed or electronic)
Book (printed or electronic)
Web Page (corporate web page, blog entry, YouTube video, etc.)

If you prefer a more narrative explanation, see Purdue OWL’s handouts for how to create a bibliography entry for a book, an article in
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a periodical (such as a journal or newspaper), or an electronic source (such as an email, web page or a YouTube clip). See also this
list of other common sources (such as a personal interview or a movie).

5.2.  How to Organize Your Works Cited list
Sort the entries alphabetically by the author‘s last name.

If the author is an organization (such as a government agency or non-profit foundation), alphabetize according to the name of
the organization.
If you are citing a painting, or a composer, then obviously “author” has to be interpreted a little loosely.

Unless your instructor ask you to organize your Works Cited list differently, everything should be alphabetized together, in a single
list. MLA does not require that you separate works of different kinds, or that you cite works in the order that they appeared in your
paper, or that you write annotations to go along with each item.

29 May 2011 — new document posted, replacing outdated handout written in 1999.
06 Jun 2011 — expanded section on organizing the Works Cited list, since several readers asked for clarification.
07 Jun 2011 — reorganized for emphasis
19 Apr 2012 — added numbers to more subheads 

Related Writing Links

Dennis G. Jerz
Researched Papers: Using Quotations Effectively
If your college instructor wants you to cite every fact or opinion you find in an outside source, how do you make room for your own
opinion? Paraphrase, quote selectively, and avoid summary.Dennis G. Jerz
MLA Works Cited Citation Builder
Choose a form, fill it out, and push the button… you will get an individual entry for a “Works Cited” page, which you may then copy
and paste into your word processor. The BibBuilder is more like a guide than a full-fledged utility, but you may nevertheless find it
helpful.
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Tahseen
View 22 hours ago

Thank you so much for this. I’m really grateful that there are people like you out there who help others out like
this :)

May Allah / God bless you :)

Reply

1.
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Works Cited Notes – Seminar in Thinking and Writing (LA101)
View 11 hours ago

[...] MLA Style Papers (with specific instructions that demonstrate the format for a WC list) [...]

Reply

2.

Desiree
View 15 hours ago

Thank you so much!!! I couldn’t figure out how to do this for nothing and I had begun to get points taken off of
my papers.

Reply

3.

nickolas sarmiento
View 10 hours ago

i need help on finding indenting

Reply
Dennis G. Jerzreplied:
View 10 hours ago

Nickolas, if there’s a particular instruction on this page that you find confusing, I’d be happy to help clarify,
but as it is there isn’t enough information in your request for me to be very helpful.

Reply

4.

nickolas sarmiento
View 10 hours ago

i need help on finding indenting
help me plz

Reply

5.

nickolas sarmiento
View 10 hours ago

hi

Reply

6.

Sherry
View 10 hours ago

That was great…cannot say much.I have been struggling.

Reply

7.

zackline mendy
View 1 hour 6 minutes ago

need help with mla formatting for my English class

Reply
Dennis G. Jerzreplied:
View 5 minutes ago

You’ve found the right web page, then. Let me know if any of the guidelines are unclear.

Reply

8.

MARIA
View 11 hours ago

THANKS

Reply

9.

Shellie Rourke
View 20 hours ago

That was a huge help for my final paper…thank you

Reply

10.
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Miri gavrieli-Hod
View 5 hours ago

Thank you so much. Your information to me waslike a blessing in th sky… Thanks and God bless.

Reply

11.

EILEEN HALL
View 22 hours ago

I could use your help in writting a term papper on the history and culture of the Cherrokee Indians. I need ;
Journal Articles, ten Bibliography’s two books ten sources 30 notecards on this subject, two outlines. One rough draft
andthe final outline. I have never written a term paper before, I need some serious help. Will you help me PLEASE!!

Reply
Dennis G. Jerzreplied:
View 19 hours ago

See the links in section 0.2. I’m sure your instructor would be able to help, if you ask.

Reply

12.
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